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Getting Started 
Introduction 

You're about to discover one of the easiest, most comprehensive outlining programs 
available on the market today. With PC-Outl ineTM by Brown Bag SoftwareB you can 
quickly arrange large amounts of information into an easy-to-use structure. Once your 
outline structure is in place, finding the information you need i s  a snap. 

With PC-Outline you can enter your information in any order, and the program keeps 
track of each piece. When you're ready to organize those pieces, PC-Outline provides 
an impressive list of functions to help you. Once your information is organized into an 
outline format, you can use PC-Outline to view or find your information in a variety of 
ways. 

Because PC-Outline keeps track of not only the information, but also the relationships 
to other information, your job is made easier. 

PC-Outline is more than just an outlining program. Its uses are limited only by your 
needs and your imagination. Here is a list of just a few of the ways you can use 
PC-Outline: 

To-do lists 

Project planner 

Daily scheduler 

Writing tool 

Word processor 

Procedure writing 



Class notes 

Law case preparation 

Project proposals 

Screenplay writing 

Electronic scratch pad 

The chapter "Applying PC-Outline to Your Needs" illustrates some of these uses. 

To use PC-Outline, you need an IBM PC or an IBM-compatible system with at least 
128K of internal memory and a copy of DOS 2.0 or greater. 

To install a printer see Appendix B, "Additional Printer Information." To install a 
monitor, see Appendix C, "Command Parameter Options." 

/nstalling PC-Outline lM by Brown Bag@ Software 

Note: If your copy of PC-Outline'came with WordStar 2000, you can install it as an 
additional feature of WordStar 2000. Follow the instructions in the "Starting" section 
of the WordStar 2000 documentation. 

This section explains how to install PC-Outline on a hard disk using either 51/4-inch or 
3fi-inch disks. You'll need the disk containing PC-Outline. 

1 Turn on and boot your computer so that the operating system prompt (C>) is on the 
screen. 

2 Type md\pco (or any other name you choose) and press 4 to create the directory 
for PC-Outline. 

3 Type cd\pco (or other directory name) and press 4 to change to the PC0 
directory. 

4 Insert the PC-Outline disk into your floppy disk drive. 

5 Type copy a:*.* (or the appropriate drive letter) and press 4 to copy all files on the 
disk into the PC0 directory. 

6 Remove the disk from the floppy drive and store it in a safe place. 
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This section explains how to install PC-Outline on a floppy disk system using either 
5%-inch or 31h-inch disks. You'll need the disk containing PC-Outline, a copy of your 
DOS disk, and one blank formatted disk. 

1 Insert your DOS disk in drive A and turn on and boot your computer. 

2 Remove your DOS disk and insert the disk from your PC-Outline package into 
drive A. 

3 Insert the blank formatted disk into drive B. 
4 At the operating system prompt (A>), type copy a:*.* b: and press 4. 

5 Remove the original disk from drive A and store it in a safe place. 

6 Remove the copy from drive B and use it as your working copy of PC-Outline. 

Starting ~ c - ~ u t l i n e  
Note: If you installed PC-Outline to run as an additional feature of WordStar 2000, 
choose Additional features at the Opening Menu. You'll see a list of programs that you 
instal led with your word processing software. Choose PC-OUTLINE. 

You can load PC-Outline as a non-memory-resident program or as a memory-resident 
program. These instructions tell you how to load PC-Outline as a non-memory- 
resident program. If you want to use PC-Outline as a memory-resident program, read 
the section following these instructions. 

1 Turn on the computer. 

2 At the system prompt (C>), type cd\pco (or the name of the directory you created) 
and press 4 to change to the directory containing the PC-Outline files. 

3 Type pco and press 4. 

4 After the program is loaded, you'll see the PC-Outline Opening Menu. 
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1 Turn on and boot your computer. 

2 Insert your copy of the PC-Outline disk into drive A. 

3 At the operating system prompt (A>), type pco and press 4. 

4 After the program is loaded, you'll see the PC-Outline Opening Menu. 

Loading PC-Outline as a Memory-Resident Program 
When PC-Outline is loaded as a memory-resident program, it is loaded into your com- 
puter's memory once and remains there running in the background while you run 
other software programs. When you want to use PC-Outline, you just press a special 
key combination, and PC-Outline will be displayed right in the middle of your other 
application program. 

Note: If you plan to run the memory-resident version of PC-Outline, load PC-Outline 
before you start up your word processing software. You may want to add the 
PC-Outline loading command line to your AUTOEXEC.BAT file, if you use one. 

To load PC-Outline as a memory-resident program, follow the start-up instructions 
above for your type of computer, with one exception. At the operating system prompt, 
type pcolr instead of just pco. 

This loads the program into memory and displays a short message on your screen. You 
then return to the operating system prompt. 

Once PC-Outline is loaded as memory resident, you can activate it at any time from 
any program by pressing ̂ \  (Ctrl-Backslash). When you quit PC-Outline, you'll be re- 
turned to whatever you were doing before you invoked PC-Outline. You can move 
quickly back and forth between your program and PC-Outline by pressing ̂ \ at any 
time. 

Note: Sometimes when you press ̂ \  it doesn't work. When this happens, press 4. 

T I P If you want to change ^ \  to another shortcut keystroke, use the KEYSET.COM 
utility program provided on your PC-Outline disk. 

Removing PC-outline from Memory 
If you want to completely remove PC-Outline from memory, follow these steps: 

1 Save all outlines. 

2 Exit PC-Outline and return to your other application. 

3 Exit your other application to return to the DOS prompt. 
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4 Load PC-Outline and position the cursor in the main editing mode where you can 
type into an outline (not in a menu or option box). 

5 Press ^Backspace three times in a row. PC-Outline is removed from memory. The 
memory it occupied is recovered by DOS only if there were no other memory- 
resident programs loaded after PC-Outline. 

C A U T I 0 N Don't use this command i f  another memory-resident program is 
loaded after PC-Outline. 

Where  to Go from Here 

This manual is divided into four main chapters. Where you start depends on your level 
of familiarity with computers, outlining, and PC-Outline in particular. 

If you're familiar with several software packages, but are new to outlining, start with 
the "Trying It Out" chapter. This guides you through the creation of an outline and 
covers all the options you'll need to make PC-Outline a useful tool. 

If you're familiar with other outlining software packages but are new to PC-Outline, go 
directly to the "Reference" chapter. This chapter contains detailed information about 
every menu and function in PC-Outline. 

If you're already familiar with how to use PC-Outline and you want to explore some 
real-life applications, start with the ''Applying PC-Outline to Your Needs" chapter. 
This chapter will guide you through several useful applications that demonstrate many 
of the program's features. 

Included with this manual are several sample files that are designed to be used with- 
out the manual to help demonstrate key features of PC-Outline. You can either read 
the manual alone, work through the manual in conjunction with the disk-based out- 
lines, or load the disk-based outlines and experiment from there. The choice is yours. 



Trying It Out  
If you've installed PC-Outline properly for your computer, you're ready to try it out. 

In the next few pages, you'll learn some of the basics of PC-Outline, create a new out- 
line, work with and change the outline, and print your document. 

If you haven't already done so, start PC-Outline following the directions for your type 
of computer shown in the previous chapter. 

The Opening Menu 

The first screen you see is the Opening Menu. 

The command you want is the first one on the Opening Menu, Open an Outline. If 
the highlighting is not on Open an Outline, use ? or i to move the highlighting to it. 
Press +J to choose this command. 

The PC0 File screen then appears. Type the name of your new outline and press 4. 
The filename can be any legal DOS path and/or filename without an extension. The 
e2ension .PC0 is automatically appended to the t~lename you s p e c 1 F y 7  
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I he Working Screen 

After you enter a filename, the working screen is displayed. This screen is the same for 
all work you do with PC-Outline. See the "Reference" chapter for an explanation of 
the different parts of the screen. 

window bar menu bar status column 

ruler bar message bar 

I yping with PC-Outline 

Typing with PC-Outline is much the same as typing with a conventional word pro- 
cessor. Characters are inserted into your outline at the cursor location as you type 
them. If a line gets too long, it automatically wraps to the next line. 

The cursor in PC-Outline is indicated by a reverse video rectangle. The cursor moves 
as you type, or you can move it by using special cursor movement keys located on the 
numeric keypad of your computer's keyboard. These keys are PgUp, PgDn, Home, 
End, t , J ,  +, and -+. 
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PC-Outline has several keys to help speed up editing the text of a document. A com- 
plete list of these can be found in the "Editing in PC-Outline" section of the 
"Reference" chapter. Two of the most commonly used editing keys are 

Del Deletes the character on which the cursor i s  currently located, including car- 
riage returns. All other text is adjusted accordingly. 
~ a c k s ~ a c e  Deletes the character immediately preceding the cursor, including car- 
riage returns. All other text is adjusted accordingly. 

Using Menus 

The program options available in PC-Outline appear in one of the nine pull-down 
menus, an example of which is shown below. The title of each of these menus appears 
across the top line of the screen in the menu bar. 

Before you create your first outline, remember these points about using menus: 
\ 

'-. . Choosing a Menu One way is to press the F10 key. This displays the first menu, 
the File Menu. Another way is to press the Alt key and the first letter of the menu 
name simultaneously. \. Changing Menus To choose one of the other menus, use - or -. . Choosing an Option To choose a function on any menu, move the highlighting to 
your selection using T or .1 and press 4. You can also press the letter preceding 
the option you want. 

1 . Leaving a Menu without Choosing an Option At any time before choosing an 
option, you may bypass all options by pressing Esc. This will return you to the cur- 
rent outline with no changes made. . Shortcut Keystrokes PC-Outline also offers a complete set of shortcut keystrokes 
that can accomplish many of the functions contained in the menus. These keys are 
displayed to the right of the function in the menus. See Appendix A, "Quick Key 
Reference" for a list of all the shortcut keystrokes. 

For more information about using menus and screens, see the "Reference" chapter. 
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Terminology Used in PC-outline 

This manual and some PC-Outline function names contain special terminology to 
describe an outline structure. The terminology compares an outline to a family tree 
where each member in the family has both parents and children. An outline about a 
family might look something like this: 

A .  John and Jan's family 
John and Jan Smith have four children 

1 .  Their sons 
a. Peter 
b. Paul 

2. Their daughters 
a. Kathy 
b. Kelly 

The terminology you'll encounter is as follows: 

H Element or Entry An element or entry is any single portion of an outline, for 
example, "John and Jan's family," "Paul," and "Their daughters." . Text All text that follows the first line of an element i s  referred to simply as the 
element's text. The sentence "john and Jan Smith have four children" i s  the text of 
the element "John and Jan's family." . Family Elements are arranged in families that consist of the head of the family and 
all of its children, grandchildren, etc. 

\ . Children Children are subelements grouped under an element. The element 
"Their sons" is a child of "John and Jan's family," and the elements "Peter" and 
"Paul" are children of "Their sons." 

Parent Parent i s  the element under which all elements on a level are grouped. 
The element "Their daughters" is a parent of the elements "Kathy" and "Kelly." In 
turn, the element "John and Jan's family" is a parent of the elements "Their sons" 
and "Their daughters." 

Creating Your First Outline 

Now it's time to build your new outline. You should have a blank working screen on 
your monitor with "A." in the left-hand corner of the screen. Follow these steps to cre- 
ate the outline: 

1 Type the word January. 
2 Press the F10 key, use the cursor keys to display the Outline Menu, and choose 

Create New Outline Entry. 
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3 Type February next to "B." 

4 Continue to enter the months March through June. You can create new elements as 
you did in step 2 above, or you can use the shortcut keystrokes or ^N. (Be sure 
to press after typing the word "June.") 

Your outline should now look like this: 

- 

A. J a n u a r y  

B. F e b r u a r y  

C .  Ma rch  
D.  A p r i l  

E .  May 

F .  June 

G.  I 

5 Use .T to move the cursor to the position directly below March, then press- once. 
You'll notice that this creates the subelement "1 ." 

6 Type July and press ̂ d. Notice that a new subelement is created at the same level 
as 1. By using the cursor keys before you type anything into an element, you can 
change its level. 

7 Type August and pressA+J. 

8 Move the cursor to the position below June (G.). 
9 Finish typing the outline so it looks like this: 

A .  J a n u a r y  

B. F e b r u a r y  

C .  Ma rch  

1 .  J u l y  

2 .  Augus t  

D. A p r i l  

E .  May 

F .  June  

G.  September  

H.  O c t o b e r  
I. November 

J .  December 

K .  The 1 3 t h  m o n t h 1  
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Hiding and Showing Text and Children 
PC-Outline has the ability to hide and show (unhide) various parts of the outline. 
Using the sample outline you've created, follow these steps: 

1 Move the cursor up to "March." 

2 Display the Hide Menu and choose Current Entry's Children. Notice that "1. July" 
and " 2 .  August" disappear from the screen. These elements still exist; they are just 
hidden until you decide to show them again. 

3 You can also hide and show outline elements using the gray + key to the right of 
the numeric keypad. Press the gray + key twice. "1. July" and "2. August" wil l  
reappear and then disappear again. 

4 Display the Show Menu and choose Current Entry's Children. "1. July" and 
"2. August" reappear. 

As you can see, there are many different ways to hide and show outline elements. 

Moving Elements 
Since the months still aren't in order, follow these steps to rearrange them: 

1 Move the cursor to "1. July" if it isn't already there. 

2 Choose Move Outline Entries from the Outline Menu. The element number and 
the element itself will be highlighted. 

3 Using the cursor keys, position "July" under "June." Notice that PC-Outline auto- 
matically renumbers the outline as you move the element. 

4 When the element is positioned properly, press 4. The highlighting disappears, 
and your outline should look like this: 

1 

A .  January 
B. February  
C .  March 

1 .  August 
D.  A p r i l  
E .  May 
F .  June 
G.  J u l y  
H.  September 
I. October 
J .  November 
K .  December 
L .  The 1 3 t h  month 

5 Now repeat the same steps to move "August" to its proper place. 

352 
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Deleting Elements 
You can also delete elements that you don't want. Since there are only twelve months, 
eliminate the last outline entry by following these steps: 

1 Move the cursor to the last line in the outline. 

2 Choose Delete Outline Entries from the Outline Menu. 

3 You will see a message asking you to confirm this deletion. This gives you a chance 
to change your mind since you could accidentally delete an element and all of its 
children with this command. Move the highlighting to "Yes" and press 4 to delete 
the last line. 

Printing an Outline 
When you are finished creating an outline, you'll probably want to print it. To print 
the outline you just created, follow these steps: 

I Make sure your printer is connected to your computer, loaded with paper, turned 
on, and online. If you don't know how to do any of these things, refer to your 
printer manual. 

2 If any of your outline elements are hidden, choose All Text and Children from the 
Show Menu to expose the entire outline. Parts of the outline that are hidden will 
not print unless you first show them on screen. 

3 Choose Go Start Printing from the Print Menu. Your printer should respond quickly. 
If it doesn't, press ̂ Break (this stops printing) and then repeat all of these steps. 

Note: The printing in PC-Outline is designed for quick, draft printing. If you want to 
take advantage of more elaborate print functions, use the Set Device for Output func- 
tion on the Print Menu. This function allows you to convert your outline to various file 
formats. See "Set Device for Output" in the "Using the Print Menu" section in the 
"Reference" chapter. 

Saving an Outline 
Now that you've created and printed your outline, you should save it to disk the way 
you'll save all the outlines that you create in the future. Choose Save Current Outline 
from the File Menu to save your outline. For more information about this function, see 
the "Reference" chapter. 

Quitting PC-Outline 
When you're finished using PC-Outline and have saved all work you want to keep, 
choose Quit PC-Outline from the File Menu. 

Once your work i s  saved, you'll be returned to the operating system prompt or to the 
other program that was running when you started PC-Outline. 

1 I P Remember that you can also return to your other program by pressing ̂ \. 
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What's Next? 
At this point, you know everything necessary to use PC-Outline. Try creating several 
outlines that you find useful. If you run into trouble, refer to this chapter or read about 
a particular function in the "Reference" chapter. 

Once you're comfortable with PC-Outline, move on to the "Applying PC-Outline To 
Your Needs" chapter. This chapter contains several applications designed to demon- 
strate new uses for PC-Outline. See if some of these meet your needs. 



Reference 
The first few pages of this chapter tell you how to use the menu system and how to 
enter necessary information. The second part describes the functions that appear on 
each menu. 

Using the Menus and Screens 

The next few pages explain the methods and options for using the menus and screens 
in PC-Outline. 

Choosing a Menu 
\ You can use two methods to choose a menu: 

One way is to press the F10 key. This displays the first menu, the File Menu. From 
the File Menu, you can use +- and + to move from one menu to another. To choose 
a function from a menu, use t and 4 to move the highlighting to that function and \ press 4. 

Another quick way to display a menu i s  to press the Alt key in combination with 
the first letter of the menu you want. For example, to display the Window Menu, 
press Alt-W. 

Choosing a Function from a Menu 
Once you're in a menu, you can use one of these two methods to choose an item: 

Use t and 4 to move the highlighting to the function you want and press 4 

\ Press the letter preceding the function you want. 
L. 

You can also select a function directly from the working screen by pressing the Alt key 
with the menu and function letters. For example, press Alt-FS to choose Save Current 
Outline from the File Menu. 
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\ Leaving a Menu without Choosing an Option 
1 

At any time before choosing a function from a menu, you may bypass all options 
by pressing the Esc key. This returns you to the current window without making 
any changes. 

Shortcut Keys 
Many of the more common menu options also have shortcut keystrokes that complete 
the same function. These keystrokes are listed to the right of the option shown on the 
menu. For example, the shortcut for the Current Paragraph Style function on the Dis- 
play Menu is ̂ T. 

T I P You can add shortcut keys or change the existing ones using the built-in macro 
facilities. For more information, see "Key Definition" in the "Using the Advanced 
Menu" section of this chapter. For a complete list of original key assignments, see 
Appendix A, "Quick Key Reference." 

Option Boxes 
Some menu selections lead to an option box from which you may change several pro- 
gram settings at once. All of these boxes work the same way: 

rn To move from one setting to another, use t and A .  
To change a setting, put the cursor on the desired option. The message bar (the bot- 
tom line of the screen) indicates what you should do to change the current option. 
There are three types of options: 

Choices Using + or the Spacebar, cycle through the predefined choices for this 
particular option. Use +--to cycle through the choices in reverse order. You can also 
press the first letter of the desired option to choose it directly. 

Numbers Enter the new number by typing it over the existing number. If you hear 
a beep when you try to leave a number option, it i s  because you entered an invalid 
number. 

Text Enter the appropriate new text. 

rn To confirm a new setting, simply move to another option or press 4 if you're 
finished with all options. If you move to another option, an arrow appears beside 
the setting to indicate that it has been changed. 
To avoid changing a setting, press Esc or 4 before you move to a new setting. 

rn To save your changes to the program start-up file so they will be active the next 
time you start PC-Outline, press F10. 

1 To exit an option box, press 4. 
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Specifying Ranges 
Many of PC-Outline's functions require that you specify a range, or portion of the out- 
line, for use with the function. For example, the Copy Block function requires that you 
mark the range of text to be copied. To specify the range, position the cursor at one 
end of the range and then choose the function you want. The range begins at the loca- 
tion of the cursor when the function is chosen. To extend this range, use the standard 
cursor movement keys ( t  , J ,  PgUp, PgDn, etc.). The range you define is always high- 
lighted. 

If you decide you want to cancel the currently selected function while marking the 
range, just press Esc. When you're finished specifying the range, press 4 to complete 
the operation. 

The Working Screen 

window bar menu bar status column 

I I I 

I 

ruler bar 
I 

message bar 

The screen shown here will be the same for all work you do with PC-Outline. The 
important parts of this screen are as follows: 

W The Menu Bar This is the top line of the screen. Each of the words you see is the 
title of a menu. To view these menus, see "Choosing a Menu." 
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H The Window Bar This is the line immediately below the menu bar. This line con- 
t '  . ~ ~ ~ t h * ~ a x n p w i o d o w : t h ~ t e  DOS path a r m  

,for this outline, the size of the outline in bytes, the nsert or overstrike mode indica- 
~JZ, the cursor position, the system clock time, and the w~nciow number. 

Note: On some IBM-compatible systems, the time may not be the same as your 
system time. If this is the case, you must run the program GOODCLK.COM each 
time you boot your computer before you run PC-Outline. 

H The Status Column This i s  the column on the right, just inside the window 
border. This column can contain the following symbols: (1) a highlighted down 
arrow directly across from the bottom of an element indicates that there are hidden 
children of this element, (2) a dash means there are no children, and (3) a high- 
lighted dash means that there is hidden text. 

The Ruler Bar This line is located just above the message bar at the bottom of the 
screen. The ruler bar shows the margins, tab stops, and cursor position. 

H The Message Bar This line appears at the bottom of the screen and contains help- 
ful information about what you are currently doing. If you get stuck, look at this 
line for help. 

PC-Outline has just one editing mode, whether you're editing text or your outline 
structure. There are different keystrokes available to edit text and outlines. 

Editing Text 
Use the following keys to edit text in PC-Outline: 

K E Y S  F U N C T I O N  

t .1 Move through text like word processor 
+-- 

Shift-- Deletes word to the right 

Shift- - Deletes word to the left 

Moves cursor to right one word 

A+-- Moves cursor to left one word 

^Home Move cursor to beginning of outline 

Shift-Home 

*End Move cursor to end of outline 

Shift-End 

"Y Deletes text line 

Shift-Del Deletes to end of line 
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Editing Outlines 
Use the following keys to edit the outline structure in PC-Outline: 

K E Y S  

T .l 

Shift- r 

Shift- & 

F U N C T I O N  

Move a family being moved with AM or an empty inserted heading up 
or down from heading to heading 
Moves cursor up from heading to heading on the same (if it exists) or 
higher level 
Moves cursor down from heading to heading on the same (if it exists) 
or higher level 
Move cursor up or down from paragraph to paragraph 

Moves cursor up to parent heading 
Create entry at same level. Immediately press + or + to change the 
entry level. 

See Appendix A, "Quick Key Reference," for a complete list of all editing and short- 
cut keystrokes. 

using the File Menu 
The File Menu contains the following functions: 

Save Current Outline (3) 
This function saves the current outline under the filename displayed in the upper left 
corner of the window bar. The filename extension .PC0 is added to the name. 
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Each time you save a file, PC-Outline saves the previous version as a backup file and 
gives the backup filename a .BAK extension. To recover a backup version, rename it 
to change its extension from .BAK to .PCO. 

T I P The automatic backup feature can be turned off using the Configuration Settings 
option on the Advanced Menu. 

Load Existing Outline 
Use this function to load a file into the current window from a list of all outlines in the 
current directory. This function replaces the contents of the current window. 

If there are no outline files in the directory, you will be prompted automatically for a 
new filename (see "Start New Outline"). 

\ T P The list of files is sorted in date and time order, the newest files first. l f  you set 
the DOS time and date correctly, you wil l  find the outlines you worked on most re- 
cently are the first ones in the list. 

Start New Outline 
Use this function to create a new outline in the current window. The contents of the 
current window are replaced with the new outline. You can enter just a DOS filename 
or a complete path and filename, but do not enter a filename extension. 

8: Sfe*Zrl/ gJ.&rhtvvlP/ 

If the filename you type does not exist, a new blank outline is created in the current 
window. If the file does exist, i t  is loaded from disk. 

Rename Current Outline 
Use this function to rename the outline in the current window. 

To save an outline to a disk drive other than the default drive, simply rename the out- 
line by specifying the new drive with the same filename. 

Change Current Drive or Directory 
Use this function to specify a new default drive or directory name. You may specify 
just the new drive, for example, C:, or a complete directory path name, for example, 
C:\OUTLINE\TODO. 

Outlines in existing windows are still saved to the directory from which they were 
loaded regardless of the current default directory. To save them to a different location, 
use the Rename Current Outline function. 

Note: You can always start from the same directory by specifying the directory name 
using the Configuration Settings function on the Advanced Menu. If no value i s  spec- 
ified, the starting current directory will be set to the DOS current directory when 
PC-Outline i s  loaded. 
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File Options 
This function displays a submenu of options for directory maintenance. 

Pick a Subdirectory 
Use this function to choose a new current directory from a list of the subdirectories in 
the current directory. 

Set Parent Directory 
Use this function to make the current directory be the directory above the current 
directory in the directory tree. 

Create New Subdirectory 
Use this function to create a new subdirectory in the current directory. 

Erase an Outline 
Use this function to delete an outline from the current directory. You must confirm 
your choice. 

lnput Other File Types 
Use this function to read other files into an outline in PC-Outline. 

Read In an ASCII File 
This function inserts the contents of the ASCII file you specify at the cursor position in 
the current window. 

Read In a WordStar Professional 4.0 File 
This function inserts the contents of the WordStar Professional 4.0 file you specify at 
the cursor position in the current window. 

Read In a Structured File 
This function inserts the contents of the file you specify at the cursor position in the 
current window. This type of file is compatible with ThinkTankTM and Ready!'" and 
contains outline structure. 

To transfer information from another PC-Outline file, ThinkTank, or Ready! to 
PC-Outline, save an outline in ThinkTank to structured format (or just save an outline 
normally in Ready!), create a blank outline in PC-Outline, and then read the file into 
the blank outline with this function. 

Note: If you want to read in a PC-Outline file, first write the file to a structured format 
using Set Device for Output at the Print Menu. Then read in the structured file using 
lnput Other File Types as described here. 

Read In a WordStar Classic 5.0 File 
This function inserts the contents of the WordStar Classic Release 5.0 file you specify 
at the cursor position in the current window. 
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T I  P The structured file format has several other uses because it is both an ASCII for- 
mat and i t  maintains the outline format. One way to check spelling in an outline is to 
write i t  to a structured file format (see "Set Device For Output" in the "Using the Print 
Menu" section), check the spelling, and then read the corrected file back into 
PC-Outline. Because the normal outline file format i s  not ASCII, i t  cannot be checked 
for spelling directly. 

Read In a WordStar 2000 File 
This function inserts the contents of the WordStar 2000 file you specify at the cursor 
position in the current window. 

Quit PC-Outline 
Use this function to exit PC-Outline. In the memory-resident version, this function just 
returns you to the application that was active when you started PC-Outline. You can 
also leave the memory-resident version of PC-Outline by pressing ̂ \. 

Using the Outline Menu 
The Outline Menu contains the following functions: 

Move Outline Entries (-M) 
Use this function to move the current element and all of its children to a new location 
in the outline. After selecting the function, you will be prompted to move the entry to 
a new location with the cursor keys. When the element moves, the outline numbering 
is automatically adjusted to reflect its new location. 

Note: When you start this function, the children and text of the element are tempor- 
arily hidden to give you a clear view of where you are moving the outline family. 

T I  P To move a number of outline elements all at once, use the MarklUnmark Out- 
line Entry and Move Marks commands also located on the Outline Menu. 
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Delete Outline Entries (-D) 
Use this function to delete an outline entry and all of its children. 

Note: You'll be prompted for confirmation before the entry is actually deleted. If you 
don't want to be prompted for confirmation, you can start PC-Outline with the /p com- 
mand parameter. See Appendix C, "Command Parameter Options," for more 
information. 

Create New Outline Entry (^s or ^N) 
Use this function to create a new outline element after the current element at the same 
outline level. 

After you've created the element, but before you've typed anything into it, you can 
move the element to a new location using the -, -, T or .1 keys. Pressing any other 
key cancels this movement mode. For example, to create a new outline element that is 
a child of the current element, press or A N and then press - to indent the new 
entry to the next level. 

MarklUnmark Outline Entry 2 
Use this function to mark or unmark an element and all of its children. Once an ele- 
ment is marked, you can promote, indent, copy, or move it using one of the other 
Outline Menu commands. 

Marking an element marks the entire outline family, and you can mark several ele- 
ments before you actually perform some movement activity. You are not allowed to 
mark or unmark any children of a marked entry because they are already marked by 
virtue of their parent being marked. 

To unmark a marked entry, position the cursor at the top of the marked family and 
repeat this function. 

Promote Marks (F7) 
Use this function to move all marked outline elements one outline level to the left. 

E X A M P L E  

Before promoting marks: 

A .  P a r e n t  E lement  

1 .  F l r s t  C h i l d  

2 .  Second C h i l d  

3 .  ~ h  1  r d  c h  1  i d  -This element marked 
4 .  Four  t h ch  1  i d  -This element marked 

363 
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After promoting marks: 

A .  Parent  Element 
1 .  F i r s t  C h i l d  
2 .  Second C h i l d  
B. T h i r d  Child-ThiselementpromoZed 
C . Four t h C h i 1 d -This element promoted 

Note: Only the last element on a level or a series of last outline elements on a level 
can be promoted. If you are trying to promote an illegal entry, PC-Outline ignores 
the command. 

TI P To promote an element in the middle of a level, you must first indent al l  the ele- 
ments on the same level. 

Indent Marks (F8) 
Use this function to move all marked outline elements one outline level to the right. 

E X A M P L E  

Before indenting marks: 

A .  Parent  Element 
1 .  F i r s t  C h i l d  
2. Second C h i l d  
3. Th i r d C h i 1 d - This element marked 
4 .  F o u r t h  child-Thiselementmarked 

After indenting marks: 

A .  Parent  Element 
1 .  F i r s t  C h i l d  
2 .  Second C h l l d  

a .  Th i r d Ch 1 1 d-This element indented 
b .  F o u r t h  Child-Thiselementindented 
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All elements but the first one on a level may be indented. If you are trying to indent an 
illegal entry, PC-Outline ignores the command. 

Copy Marks (F9) 
This function copies all marked outline entries to the location following the current 
element at the same outline level. Copy Marks is useful for duplicating a series of out- 
line entries several places in the outline. 

Note: You cannot use Copy Marks to copy outline entries to a location within a cur- 
rently marked family. This prohibits you from copying an outline family to the position 
immediately after a marked family. To accomplish this task, simply copy it before the 
marked family. If you just want to duplicate the marked element, the order will not 
matter (they are duplicates of each other). If you want to copy it after a marked ele- 
ment that isn't the same, copy the original to a location before the location you want, 
and then move it to the location you want using Move Outline Entries. 

Move Marks (Shift-F1 0) 
This function moves all marked outline entries to the location immediately following 
the current element at the same outline level. 

Note: You cannot use Move Marks to move outline entries to a location within a cur- 
rently marked fami ly. 

T I P Move Marks is useful as an information-gathering function. You can browse 
through your outline, marking all the elements that you want to gather at a new lo- 
cation, and then move them to the new location with one keystroke. 

join Outline En tries ('-1) 
This function joins the current element to the next sequential outline element at the 
same level to form one new element. 

EXAMPLE 

Before joining elements A. and B.: 

A .  Flrst E l e m e n t 1  
B. Se c o n d  Element 

1 .  First C h i l d  
2. Sec o n d  C h l l d  

C. T h i r d  Element 
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After joining elements A. and B.: 

A .  F i r s t  E l e m e n t 1  
S e c o n d  E 1  e m e n  t  - This element joined to A. 
1 .  F i r s t  C h i l d  
2. S e c o n d  C h i l d  

B. T h i r d  E l e m e n t 4  This element renumbered 

Note: The Join Outline Entries function works only when two sequential elements 
are on the same level and the first element does not have any children. 

Divide Outline Entries U) 
This function divides one outline element into two elements. Any children of the orig- 
inal element are reassigned to the new element. 

E X A M P L E  

Before element A. is divided: 

A. F i r s t  E l e m e n t  C u r s o r  H e r e 6 C ~ r S o r  0n "C" 
1 .  F i r s t  C h l l d  
2. S e c o n d  C h i l d  

B. T h i r d  E l e m e n t  

After element A. is divided 

4. F i r s t  E l e m e n t  
B. C u r s o r  H e r e d  Newly created element 

I . F 1 r  s t  c h  1 id Children assigned to B. 
2. S e c o n d  C h i l d  

C. ~ h l t - d  E l e m e n t 4  This element renumbered 
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Sort Outline Level 
Use this function to sort all outline elements in one family on one particular level of 
the outline. For example, a sort of the following outline with the cursor positioned as 
shown would sort the elements First, Second, Third, and Fourth Child. 

E X A M P L E  

Before sorting: 

A. Parent Element 
1 .  First child1 
2. Second Child 
3. Third Child 

a. Child of Third Child 
4. Fourth Child 

B. Element After Parent 

After a decreasing order sort: 

A. Parent Element 
1 .  Third Child 

a. Child of Third Child 
2. Second Child 
3. Fourth Child 
4. First child1 

B. Element After Parent 

'V 

Note: When an outline level is sorted, the children of each element remain attached 
to it and move along with it in the sort. 

Sorts are controlled by the following settings: 

Sort Direction Can be either increasing or decreasing order. 

Type of Sort Can be either (1) Dictionary order: punctuation, numbers, letters 
(without regard to uppercase/lowercase), blanks; or (2) Pure ASCII order: blanks, 
punctuation, numbers, uppercase letters, lowercase letters. 

Field Number to Sort Can be 0 through 9. 
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A field begins immediately after a colon. For example, there are three fields in the out- 
line in the example below. The 0 field starts at the beginning of each outline entry, and 
each new field begins after a colon. 

E X A M P L E  

A .  P a r e n t  Element  < F i e l d  # 1 )  ( f i e l d  #2)  
1 .  F i r s t  C h i l d  : Name1 :Address1 
2 .  Second C h i l d  : Name2 :Address2 
3 .  T h i r d  C h i l d  : Name3 :Address3 

a .  C h i l d  o f  T h i r d  C h i l d  
4 .  F o u r t h  C h i l d  : Name4 :Address4 

If you sort by the Field 1, the sort i s  done based on the characters following the first 
colon. When fields are used to their best advantage, they can give PC-Outline some 
simple database capabilities. 

using the Edit Menu 
The Edit Menu contains the following functions: 

Insert Deleted Text (AIf-U) 
Use this function to restore the last characters you erased or deleted. You can undo the 
deletion if you used commands to delete a block, a word, a line, or the rest of the line. 
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Find String C F) 
Use this function to search an outline for the first occurrence of any word or phrase 
(string) you specify. There are three settings that control a search: 

w Search for what string? Type the exact string to be searched for. A ? may be used 
as a wild-card character to match any character. For example, if you want to find 
all occurrences of either "play" or "pray," you could search for "play." Do not put 
a ? at the beginning of a search word because the first character matches everything 
and wil l  significantly slow down the search. 

w Force case to be the same? A "Yes" answer finds a match only if capitalization 
matches perfectly; a "No" answer finds a match regardless of capitalization. 

w Search scope? Choose Only ON entries to search only the portions of the outline 
that are not hidden. Choose All entries to search the entire outline and unhide any 
parts where a match i s  found. 

Searches are circular. If you start the search near the end of the outline and no matc- 
hes are found, the search wil l  continue at the beginning of the outline. If no matches 
are found on a search, you wil l  just hear a beep. 

Find and Replace (  ̂R) 
This function works exactly the same as the Find String function except that it allows 
you to replace the matching string with another string. Use these three settings, plus 
those described for Find String, to control this function: 

w Replace with what string? Type the exact string you want as a replacement for the 
matched string. 

w Ask before replacing? Specify whether you want to be prompted for confirmation 
before each replacement. 

w All Occurrences? Specify whether you want to replace all matches or just the 
next match. 

Find Again (;4) 
Use this function to find the next match of the last string specified with Find String 
during this session. 

Note: The Find Again function uses the same settings you selected for the original Find 
String operation. 

T 1 P This function is useful for moving around in the outline. For example, you could 
mark a number of places in your outline with four asterisks (***a). You could then 
search for I**** I' and use the Find Again function to move from one place to the next. 
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Copy Block PC) 
Use this function to copy a block of text (not outline structure) from one outline loca- 
tion to another. Follow these steps to copy a block of text: 

1 Position the cursor at the start or end of the block of text you want to copy. 

2 Choose Copy Block from the Edit Menu or press ̂ C. 
3 Position the cursor at the other end of the block (the text between the two ends will 

be highlighted). 
4 Press 4 to finish marking the block. 

5 Position the cursor where you want the marked text copied. You can switch win- 
dows with the Alt-# command if you want to copy text to another window. 

6 Press 4 to complete the copy. 

Note: The Copy Block function works on text only. A marked block may span outline 
boundaries, but outline structure is  not copied, only the text in each outline entry. 

Move Block (* B) 
This function works just like Copy Block except the text is moved instead of copied 
(the original copy of the text is deleted after the new copy i s  inserted). 

Delete Block (  ̂E) 
This function works the same as the Move Block and Copy Block functions except that 
the block i s  deleted instead of copied or moved. 

If any outline elements are left empty after a Delete Block (and they don't have any 
children or their children are also empty), they are deleted from the outline structure, 

Printer Format 
This function allows you to make use of your printer's special features like boldface, 
underline, italics, etc., by inserting codes into your outline that instruct your printer 
where to start one of these special features and where to end it. These are the settings 
to use: 

F U N C T I O N  NAME F U N C T I O N  K E Y  

Underline On A F1 
Underline Off ^ F2 
Boldface On ^ F3 
Boldface Off ^ F4 
Italics On ^ F5 
ltal ics Off ^ F6 
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F U N C T I O N  N A M E  F U N C T I O N  K E Y  

Superscript On Shift-F7 
Superscript Off Shift-F8 
Subscript On "F7 
Subscript Off " F8 
Double Strike On Shift-F5 
Double Strike Off Shift-F6 

To use one of these features, position the cursor first at the beginning and then at the 
end of where you want it to take effect, and either choose the appropriate menu 
option or press the function key combination you want. 

The codes appear in one of three ways in your outline: 

If the cursor i s  positioned over the character where the code was inserted, the bot- 
tom line of the screen tells you what the code is (for example, "BOLDFACE ON"). 

w If the cursor is not positioned over the character and printer code display is turned 
off, the character where the printer code is inserted appears in a different intensity 
than the rest of the text. (See also "Printer Code Display" in the "Using the Print 
Menu" section.) 

If the printer code display i s  turned on, the printer code is displayed as a graphics 
character. You can then edit the graphics character just like any other character. 
Graphics characters pointing to the right mean a print feature is on, and graphics 
characters pointing to the left mean a print feature is off. 

T I P  The best approach is to turn on the display so you can then edit the codes as if 
they were normal characters. 

Indent Paragraph (^I) 
Use this function to move the left margin of the current paragraph to the next tab stop. 

E X A M P L E  

Before indenting: 

T h i s  is a  normal p a r a g r a p h  t h a t  w e  w i l l  show both b e f o r e  and 
after a n  indent. Y o u  c a n  either c h o o s e  t h i s  f u n c t i o n  f r o m  

t h e  m e n u ,  or you c a n  u s e  t h e  shortcut keystroke A I .  
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After indenting: 

r 

Thrs is a normal paragraph that we wrll show both before 
and after an rndent. You can erther choose thrs functron 
from the menu, or you can use the shortcut keystroke "I. 

Repeat this function to indent more than one tab stop. If you want to indent a number 
of paragraphs at once, use Range Paragraph Style on the Display Menu. 

This function can be undone with Clear lndent (*X). 

Indent and Hang PO) 
This function works exactly like the lndent Paragraph function except that the first line 
of the paragraph is not indented. This is useful for creating hanging indents as shown 
below. 

E X A M P L E  

These next two paragraphs contain examples of hanging indents: 

Thls paragraph and the one below both contain hanglng rndents. 
The frrst line has a left margrn of 1 while the rest of 
the lrnes have a left margin of 6. 

1 )  Thrs IS also a type of hangrng ~ n d e n t .  The frrst llne IS 
not indented so we can type the number where we want ~ t ,  
but the rest of the lrnes are indented to grve this 
effect. 

T I P You can undo a hanging indent by choosing Current Paragraph Style from the 
Display Menu and setting First Line Alignment back to SAME AS REST OF PARA- 
C RA PH and the Left Margin back to 1 .  

Clear lndent (^X) 
Use this function to undo an lndent Paragraph command and set the left margin back 
to 1. 
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Page Breaks 
This function allows you to insert two types of page break controls into your outline to 
divide it into separate pages during printing. 

Hard Page Break 
A hard page break instructs PC-Outline to start a new page wherever you insert the 
break. To insert a hard page break, choose this function and type .P. 

A page break appears in your outline in one of three ways: 

Whenever you position the cursor anywhere in the line where a hard page break is 
located, a ".P" is  displayed on the bottom line of the screen. 

If the page break is not located on an empty line, the page break location i s  dis- 
played in reverse video. 

The left-hand column of the screen always contains a square bullet (or quad) on the 
line where the page break is located. 

To delete a page break, position the cursor exactly on the location where you inserted 
it, choose the Page Break function, delete the ".P", and press d. 

Conditional Page Break 
A conditional page break allows you to specify that a certain number of lines of text 
must stay together on one page. If the lines won't all fit together at the end of the cur- 
rent page, a new page will be started before them and all the lines will appear 
together on the top of the next page. 

To insert a conditional page break, position the cursor at the top of the range to keep 
together, choose the Page Break function, and type .C n (n  is the number of lines to 
keep together). 

Tab Stops 
Use this function to set tab stops wherever you want. Move the cursor along the ruler 
line when it appears, and set or clear tab stops where you want them. The ruler is 
saved with your outline and affects the entire outline. There is only one ruler per out- 
line. 
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using the Display Menu 
The Display Menu contains the following functions: 

Current Paragraph Style (  ̂T) 
Use this function to control the format of the current paragraph. These optional five 
settings appear in the Current Paragraph Style option box: 

~ a r a ~ r a ~ h i ~ l i ~ n r n e n t  Choose one of these four options to control the paragraph 
alignment: 

Left Aligned: Left edge even, right edge ragged. 

Justified: Left and right edges even. Extra spaces are inserted between words to 
align justified paragraphs. 
Centered: Left and right edges ragged. Extra spaces are added before and after the 
line to center it between the margins. 

Right Aligned: Left edge ragged, right edge even. 

First Line Alignment Controls the left margin setting for the first line of a para- 
graph. Choose one of these two options: (1) keep the first line the same as the rest 
of the paragraph, or (2) make the first line flush left. 

Left Margin Controls the starting left column for each paragraph. Left margin val- 
ues are always relative to the start of the outline entry. For example, a left margin of 
1 always starts in the first column of the outline entry regardless of how far indented 
the outline entry is. If the outline entry i s  indented 12 spaces, a left margin of 1 
starts in column 13 (12+1). 

Right Margin Allows you to change the right margin. Like the left margin, the 
right margin is relative to the start of the outline entry. For example, a right margin 
of 65 in an outline element that i s  indented 12 spaces is  actually in column 77 
(1 2 + 65). 
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See "Even Right Margins" for a discussion on how to set the right margin to an 
absolute column (instead of a relative column as described above). See "Range 
Paragraph Style" for a discussion on how to set several paragraphs all to the same 
format. 

Make Default Settings Use this function to make the default paragraph settings 
the same as the current paragraph settings. This setting is an easy way to change 
the default settings and works just like the Default Paragraph Style function. 

T I  P When you first start a new outline, choose Current Paragraph Style and set 
the margins you want for the current document. Then answer "Yes" to this ques- 
tion, and all subsequent paragraphs wi l l  get the new format. 

Range Paragraph Style 
This function works just like the Current Paragraph Style function except that it 
prompts you to mark a range and modifies the paragraph format for the entire range. 

The settings in the Range Paragraph Style option box are identical to those in the Cur- 
rent Paragraph Style option box except that this function does not include the default 
settings choice. See the previous discussion on "Current Paragraph Style" for a 
description of each setting. 

Note: Only the settings that you actually change (marked with an arrowhead) will be 
applied to the range. If you want a setting that is already correct to be applied to the 
range, you must reenter the setting. For example, if the right margin already says 70 
and you want it to be 70, you must reenter the 70 before it will work properly. 

Default Paragraph Style 
This function controls the format of all future paragraphs created whenever you press 
the 4 key. The settings are the same as those for Range Paragraph Style and Current 

. Paragraph Style. See those previous sections for a discussion of the settings. 

\ Pressing F10 in this option box saves the current settings to the configuration file 
PCO.CFG so that they will be loaded automatically the next time you start 
PC-Outline. 

Global Outline Style 
This function leads to an option box that contains 20 settings that control the outline 
format. 

'\ Indent Per Outline Level 
I 

Use this setting to specify the number of spaces of indent per outline level. The default 
value is 3 spaces per level. You can change this setting to any value between 0 and 20. 
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-\ Spaces For Numbering 
Use this setting to specify the indent for the top outline level (the numbers for the top 
outline level have to fit in this number of spaces). This defaults to a value of 4. If you 
set i i  i o  less than 4, some of the numbers may be truncated. 

T I P Roman numerals in particular require a setting of at least 6. If you ever get a 
numbering sequence that looks like I, 11, 11, i t  is probably because you haven't 

-\ 
increased the spaces for numbering to 6 and the leftmost I in 111 is being truncated. 

\ First Entry Number 
This setting allows you to control the beginning number of the top level of your out- 
line. A setting of 1 starts the top level with 1 or A or I, etc., depending on which 
numbering type you choose. A setting of 3 starts the top level with 3 or C or Ill, etc. 

Note: This setting is provided in order to allow you to link the numbering styles of sev- 
eral outlines. For example, because each outline is limited to 64K, you could divide a 
very large outline into several smaller outlines and specify their first entry numbers 
accordingly. 

Numbering Type 
This setting gives you global control over the type of numbering scheme. The global 

' options are as follows: 

\ Sequential Numbering: A, 1, a,... When you select sequential numbering, the 
numbering style for each level of the outline is determined by the eight levels of let- 
ters and punctuation you set. You can choose from five different letter or number 
combinations for each level. You can then specify the punctuation you want for 
each level. For example, you could set sequential numbering as follows: 

E X A M P L E  

A. F i r s t  Level 
1 .  Second Level 
2. Second Level 

a) T h i r d  Level 
b) T h i r d  Level 

B. F i r s t  Level 

Procedural Numbering: 1.2.2.1.3 Use this option to set the entire outline to pro- 
cedural numbering. 
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E X A M P L E  

1 . 0  F i r s t  P a r e n t  
1 . 1  F i r s t  C h i l d  
1 . 2  S e c o n d  C h i l d  

1 . 2 . 1  C h i l d  o f  S e c o n d  C h i l d  
2.0  S e c o n d  P a r e n t  
3.0  T h i r d  P a r e n t  

Bullets This option sets the entire outline to bullet numbering. This option is  in- 
cluded only for compatibility with earlier versions and should no longer be used. 
Marks will not show up in your outline if you are using this setting. The best way to 
achieve bullet numbering on all levels i s  to set this option to sequential numbering 
and set all eight levels to bullets. 

None This option turns all numbering off and has the same effect as setting the 
indent per level to 0 and spaces for numbering to 0. 

Place Outline Entry 
This function gives you ultimate control over the leftlright placement of each outline 
entry. Follow these steps to place an outline element: 

1 Position the cursor on the element to be placed. 

2 Choose the Place Outline Entry function. 

3 Using + and +, position the outline element where you want it. 

4 Press 4 when the element i s  properly positioned. 

Note: The distance you move an outline entry is always relative to its default position. 
If you move it three spaces to the left of its default position, it will always be in that re- 
lational position even if you change the default position. 

T I P This function can be combined with Skip Numbering to add nonoutline format- 
ted text in the middle of an outline formatted document. 

You can undo a Place Outline Entry by either placing it back to its default location or 
resetting all places with the Reset All Places function. 

Reset All Places 
This function resets all outline element place values to their default locations. 
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Start New Numbering 
This function restarts the numbering of the current element so that this element i s  
numbered as the first element on that level. 

Note: This function affects appearance only. Functions such as Sort and Hide ignore 
Start New Numbering. 

Skip Numbering 
Use this function to skip the numbering of the current element. To undo this function, 
use Reset Numbering. 

T I  P This function can be very useful for inserting nonoutline formatted text in an out- 
line structure. You can also combine this function with Place Outline Entry to insert 
nonoutline formatted text in an outline structure that is not indented with the rest of 
the structure. 

Reset Numbering 
This function resets the numbering of the current element to its default appearance by 
undoing Start New Numbering and Skip Numbering. 

Title Toggle 
Use this function to skip numbering on the first outline element. This works as a tog- 
gle. If the first element is numbered, its numbering will be turned off and vice versa. 

Once you set the title on, you may type the title as if PC-Outline were a word proces- 
sor. In fact, if you start a blank outline and turn the title on immediately, PC-Outline 
will work just like a simple word processor. 

Even Right Margins 
Use this function to align the right margins of a number of differently indented outline 
entries, usually before printing. This function prompts you first for a range over which 
you want to align the right margin and then for the new right margin. 

Note: Unlike other right margins that are relative to the start of the outline entry, this 
right margin is an absolute column number. This function goes through each para- 
graph in the range and calculates where to set the relative right margin in order to 
have it appear in a particular printed column. 

T I  P During the normal process of creating an outline, you wil l  end up with a right 
margin that moves further to the right as the indentation in the outline increases. To 
align the right margin right before printing, choose Even Right Margins, mark the 
whole outline, and enter the right margin you want. 
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Using the Print Menu 
The Print Menu contains the following functions: 

Go Start Printing (-P) 
This function starts printing the current block. If no range is marked, the entire outline 
is printed. 

Note: Some printers do not print bullets correctly. If you experience problems printing, 
either create a printer substitution file to correctly print bullets or remove the bullets. 
See Appendix B, "Additional Printer Information," to solve other printer problems. 

Set Range to Be Printed 
This function allows you to specify only a portion of the outline to be printed. After 
you select this function, you're prompted to mark a range to be printed. 

Set Device for Output 
This function allows you to specify the destination for printing. You will usually use 
this function to write outlines to other files as described below. 

Send to Printer Prints normally to the printer. 

Send to File Sends the exact same information that would have gone to the printer 
to a file instead. The file will automatically have the same root name as the outline, 
but with the extension .PRN. You can then use the DOS print command to print 
this file. 
Send to ASCll File Strips out all printer information and other non-ASCII charac- 
ters, such as page breaks, page numbering, etc., and sends the output to an ASCll 
file. Every line in the outline is terminated with a hard carriage return. When you 
choose Go Start Printing, you're prompted for a filename. This option can be 
useful for transferring outline formatted material to your word processor. 
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Send to WordStar Professional 4.0 File This option converts the outline to 
WordStar Professional Release 4 file format. Save the converted file in WordStar 
before printing it. 

Send to WordStar Classic 5.0 File This option converts the outline to WordStar 
Classic Release 5 file format. Save the converted file in WordStar before printing it. 

Send to Structured File Creates a specially formatted ASCll file that has ASCll out- 
line formatting information embedded in it describing the outline structure. 

Send to WordStar 2000 File This option converts the outline to WordStar 2000 
file format. WordStar 2000 high bits are retained for paragraph formatting when 
reading the file into WordStar 2000. Save the converted file in WordStar 2000 
before printing it. 

Note: After you execute a Go Start Printing function, the Device for Output is set 
back to the printer. 

set for~nat 
Use this function to select settings for many of the page formatting options like page 
size, margins, etc. The settings are as follows: 

Top Margin Sets the number of blank lines at the top of each page. The top mar- 
gin must be less than the number of lines per page minus the bottom margin. 

Bottom Margin Sets the number of blank lines at the bottom of each page. The 
bottom margin must be less than the number of lines per page minus the top mar- 
gin. 

Lines per Page Sets the total number of lines per page, including top and bottom 
margins. A standard printed page is 66 lines long with 53-55 lines actually printed. 
The number of lines per page must be greater than the top margin plus the bottom 
margin. 

Left Print Margin Sets the number of blank columns at the left side of each page. 
Although the default value i s  5, setting this to 0 allows you full access to the whole 
page. 

1 Printer Feed You have two choices based on the type of printer you have: (1) Con- 
tinuous prints the entire document on continuous feed paper without interruption, 
and (2) Pause after each page pauses at the end of each printed page for inserting a 
new sheet, 

Page Numbering You have five options for page numbering: left, right, centered, 
manually specify the column number for the page number, and off (don't print any 
page numbers). 

Page Column for Numbering If page numbering i s  set to Manually Specified, this 
option controls the starting column of the page number. 

Start Page Numbering With Starts page numbering with this value. Typically this 
i s  set to 1. 
Page Breaks Determines whether you produce a document with page breaks or a 
continuous document with no top or bottom margins and no page breaks. 
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Set Printer Font 
This function sends a code sequence directly to your printer to set it to a certain type 
characteristic. The built-in options are as follows: 

Boldfaced 

Italics 
Double strike 

Condensed 

Elite 

Note: This function immediately sends your printer a printer code and changes the 
mode of the printer for all subsequent printing. You can use it for printing an entire 
document in a particular font or for changing your printer so that some other program 
will print in the desired font. Don't confuse this function with Printer Format in the 
Edit Menu which is used for actually embedding print commands within a document. 

See Appendix B, "Additional Printer Information," to customize these options for your 
printer. 

Advance Printer One Line 
This function sends a line feed to the printer 

Advance Printer Page 
This function sends a form feed to the printer. 

Printer Code Display 
Use this function to display or hide (toggle with Alt-F1) the embedded printer codes on 
the screen. These are the Printer Format codes available from the Edit Menu. 

Note: This option distorts the onscreen location of certain parts of your outline, since 
the codes take up space onscreen that they don't take up in printing. 
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using the Hide Menu 
The Hide Menu contains the following functions: 

Current Entry's Children (. H) 
Use this function to hide all the children of the current element. You can also use 
the gray + key as a toggle to hide and show the children. 

E X A M P L E  

Before hiding the children of First Child: 

. First Parent 
1 .  First child1 

a )  First Grandchild 
b >  Second Grandchild 

2. Second Child 
a )  First Grandchild 
b )  Second Grandchild 
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After hiding the children of First Child: 

A. First P a r e n t  
1 .  First c h i l d 1  
2. Seco n d  Child 

a) First G r a n d c h i l d  
b) S e c o n d  G r a n d c h i l d  

All Children at Level ("L) 
Use this function to hide all the children of all the outline elements at the same level 
within the same family as the current element. 

E X A M P L E  

Before hiding all children at level: 
e 

A .  First Parent 
1 .  First Child 

a) First G r a n d c h i l d  
b) S e c o n d  G r a n d c h i l d  

2. Sec o n d  c h i l d 1  
a) First G r a n d c h i l d  
b) S e c o n d  G r a n d c h i l d  

B. Se c o n d  P a r e n t  
1 .  First Child 

a) Fir5t G r a n d c h i l d  
b) S e c o n d  G r a n d c h i l d  

2. Sec o n d  Child 
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After hiding all children at level: 

. F l r s t  P a r e n t  
1 .  F i r s t  child-Childrenhidden 
2 .  Second Ch l  1dl-Children h idden 

B. Second P a r e n t  
1 .  F i r s t  C h i l d  

a )  F l r 5 t  G r a n d c h i l d  
b )  Second G r a n d c h i l d  

2. Second C h i l d  

Note: This function can be reversed using All Children at Level on the Show Menu. 

Current Entry's Text 
Use this function to hide all text following the first line of the current element. You 
can also use ^PgDn as a toggle to hide and show all text fallowing the first line of 
the current element. 

All Text at Level 
Use this function to hide all text at the current level. This function operates on the 
same outline entries as All Children at Level except that text i s  hidden instead of chil- 
dren. 

All Text in Outline 
Use this function to hide all text in the outline. 

using the Show Menu 
The Show Menu contains the following functions: 
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Current En try's Children 
Use this function to show all the children of the current element. You can also use the 
gray + key as a toggle to show and hide the children. 

All Children at L eve1 
Use this function to show all the children of all the outline elements at the same level 
within the same family as the current element. This function is  the reverse of All Chil- 
dren at Level on the Hide Menu. 

Current Entry's Text 
Use this function to show all text following the first line of the current element. You 
can also use ^PgDn as a toggle to show and hide all text following the first line of the 
current element. 

All Text at Level 
Use this function to show all text at the current level. This function operates on the 
same outline entries as All Children at Level except that text i s  shown instead of chil- 
dren. 

All Text in Outline 
Use this function to show all text in the outline. 

All Children in Outline 
Use this function to show all children in the outline. 

All Text and Children 
Use this function to show everything in the outline. 

All Family Children 
Use this function to show all children, grandchildren, etc., of the current element. 

All Family Text 
Use this function to show all text in each of the children, grandchildren, etc., of the 
current element. 
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\ using the Window Menu 

The Window Menu contains the following functions: 

Load Outline New Window 
This function works exactly like Load Existing Outline on the File Menu except that 
the outline is loaded into a new window. Both the current outline and any other out- 
lines already open are all open at once. You can have up to nine windows/outlines 
open at one time. 

The window number appears in the upper right corner of the window. You can switch 
directly between windows by either pressing the Alt key and the number of the win- 
dow you want or by using the Transfer Windows function on the Window Menu. 

New Outline New Window 
This function works exactly like the Start New Outline function on the File Menu 
except that the outline is started in a new window. 

Close Window 
Use this function to close the current window and release its memory for use by other 
windows. If you have made any unsaved changes to the current window, PC-Outline 
will prompt you to save these changes. 

Note: You cannot close the last remaining window because there must always be at 
least one window open. 

Move Window 
This function allows you to reposition the currently active window on your screen 
using the cursor keys. Since the window can't be moved off the screen, you must first 
reduce its size before you have any room to move it. Use the Size Window function or 
the Zoom Window function to reduce the window size. 
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Size Window 
Use this function to change the size of the currently active window. Use the cursor 
keys to move the lower right corner to the new size. 

Note: You cannot make a window smaller than 4 lines high by 7 columns wide. 

Arrange Windows 
Use this function to return all windows to their default size and position. When win- 
dows are in their default position, they line up neatly in overlapping fashion showing 
you the top line of every open window. 

Transfer Windows (Alt 1-9) 
Use this function to switch directly to the specified window. 

List Windows (-Z) 

Use this function to list all the open windows, their window number, their memory 
size, and whether any unsaved changes have been made to the window. 

Zoom Window 
Use this function to shrink (or expand) the currently active window from full screen 
size to partial screen size (or vice versa). You can use the gray - (minus) key to toggle 
the screen sizes. 

T I P The best way to use the Zoom Window function is  to use the Arrange Windows 
function to unzoom all the windows, switch to the window you want, and then zoom 
it to full size for working. When you want to go to another window, unzoom the cur- 
rent one, switch to the window you want, and zoom again. 

Copy Family (^Q) 
Use this function to copy the entire family (the element, all children, all grandchil- 
dren, etc.) of the current element and make it a child of the location you specify. 
Follow these steps to use this function: 

1 Position the cursor at the top of the family you want to copy. 

2 Choose this function. 

3 Move the cursor to the new location for the family. You can even switch windows 
(press Alt and the window number to switch to). 

4 Press -4 to start the copy. 

Note: This function is primarily designed for copying families of outline structure be- 
tween windows. The Mark functions on the Outline Menu are usually easier to use for 
copying within the same outline. 
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Move Family (̂  W )  
This Function works exactly like the Copy Family function except the family is moved 
instead of copied. 

Using the Advanced Menu 
The Advanced Menu contains the following functions: 

Configuration Settings 
This function allows you to change 13 of PC-Outline's default settings. To permanently 
save the settings to the configuration file, press the F10 key from within the Configur- 
ation Settings option box. 

The configuration settings are: 

Cursor Delay Specify "Yes" if you want to change the cursor delay, or "No" if 
you don't want to change it. 
Speed of Cursor 1-240 You can type a number between 1 and 240 to change the 
speed of the cursor movement in PC-Outline. The fastest speed is  1 and the slowest 
speed is 240. 

Starting Directory Path Sets the starting directory for PC-Outline files. If this field 
is blank, the DOS current directory will be used as the starting directory. If you al- 
ways keep your outlines in the same directory, enter that directory here. The name 
entered in this field must be a complete DOS directory name (including optional 
path). 

Macros FileJPath Sets the pathlfilename for macro files. This defaults to 
PCOMAC.CFG (in the current directory). If you want to keep your macro files in a 
directory other than the current directory, enter that name here. The name entered 
in this field must be a complete DOS directory name (including optional path). 
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Printer Description File Sets the pathlfilename for the printer description file. 
The name entered in this field must be a complete DOS directory name (includ- 
ing optional path). See Appendix B, "Additional Printer Information," for more 
information. 

Configuration FileIPath Sets the pathlfilename for the configuration file 
PCO.CFG. Use this option if you want to keep your configuration file in a location 
other than the current directory. When PC-Outline starts up, it looks for its config- 
uration file in three places: 

1. In the current directory. 
2. In the directory and filename specified in the environment with the 

"SET PC0 = <path/filename>" command. 
3. In the directory and filename specified as a command parameter with the 

"IL = <path/filename>" command. 

If a valid configuration file isn't found in any of these places, PC-Outline starts up 
with built-in default values for all configuration settings. 

Automatic Timed File Saving If this is set to "Yes," the current outline wil l  be 
saved at regular intervals as determined by the value entered in Time Between 
Automatic Saves. The outline will not be saved if no changes have been made. 
Only the current window is saved; other changed windows are not saved. 

Time Between Automatic Saves If Automatic Timed File Saving is set to "Yes," 
this value determines how long a time interval passes between automatic saves. 

Create Automatic Backup Files If this i s  set to "Yes," each time you save an out- 
line, the previous version becomes the backup file. 

Prompt Before Overwriting If this i s  set to "Yes," you are prompted for con- 
firmation before an existing file is overwritten during a save operation. If this setting 
i s  set to "No," no warning will be given. 

Video Retrace This setting is provided to speed up screen performance on some 
computers. If you have a monitor capable of displaying graphics, experiment with 
setting this on "No." If you see snow on the screen every time you type, you can- 
not use this setting and should set it back to "Yes." If you don't see any snow on 
the screen, you can use this setting and should leave it set to "No." You can also 
set video retrace to "No" by using the command parameter "IS." 
Printer Port Sets the printer port for all printing in PC-Outline. The possibilities 
are LPT1, LPT2, LPT3, COM1, COM2, and COM3. 

Force Black and White If you have a graphics monitor that isn't color, PC-Outline 
will try to use color attributes on it. If you would prefer to only use black and white 
attributes, set this option to "Yes." You can also set this to "Yes" by using the com- 
mand parameter "IB." 
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\ Key Definition (- K) 
This function allows you to redefine keys on the keyboard by assigning from one to 
several thousand keystrokes to a single key. This function is useful for either changing 
the meaning of PC-Outline's keys or for recording frequently used phrases and attach- 
ing them to a single key. 

Follow these steps to reassign a key: 

1 Choose Key Definition from the Advanced Menu or press ̂ K. 

2 Respond to the prompt by pressing the exact keystroke that you want to redefine. 
For example, if you want Alt-N to type your name, press Alt-N here. The cursor 
changes in size. 

3 Now type the exact keystrokes that you want to be assigned to Alt-N. Using the 
previous example, type your name. 

4 When you finish typing the keystrokes to assign, press ^Break. The cursor returns 
to normal size. 

5 To save the key definition permanently, press Alt-A, then press 0 (Key Definition 
Options), and S (Save All Key Definitions). (Otherwise this key definition would be 
in effect only during the current PC-Outline session.) 

Now whenever you press Alt-N (or whatever key you reassigned), PC-Outline repeats 
the keystrokes you recorded and types your name (or whatever keystrokes you assign- 
ed to it). 

Note: While you are defining a key, no other key definitions are in effect (you must 
use the original meanings of all redefined keys). This permits you to swap the defi- 
nitions of two keys, which otherwise would be impossible. 

Key Definition Options 
This function presents a submenu with the following four options: 

Clear a Key Definition Prompts you for a key definition to clear if you want to 
unassign a definition to a key. 

Save All Key Definitions Saves all currently defined keys to a disk file called 
PCOMAC.CFG (unless you have changed the name in the Configuration Settings 
option box). These definitions will be loaded automatically the next time you start 
PC-Outline. You must save the definitions in order for PC-Outline to remember 
them. 

Inhibit All Key Definitions Temporarily suspends all key definitions. 

Restart All Key Definitions Reverses the Inhibit All Key Definitions function. 
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lnsert Static Date (Shift-F7) 
This function inserts the current DOS system date. 

lnsert Live Date (Shift-F2) 
This function inserts and continuously updates the current DOS system date. The 
screen and printing always represent the current system date. 

lnsert Static Time (Shift-F3) 
This function inserts the current DOS system time. 

lnsert Live Time (Shift-F4) 
This function inserts and continuously updates the current DOS system time. The 
screen is updated every time it is redrawn (almost every time you press a key), and 
printing is always updated. 

Export Block 
This function exports a block of an outline directly into another program. You can use 
this function only if you've loaded the memory-resident version of PC-Outline. 

C A U T I 0 N Make sure you have set the export options correctly before you start 
the exporting process. See "Export Options" below for more information. 

Follow these steps to export a block from an outline: 

I Position the cursor where you want the exported text to go in the other program. 

2 Invoke PC-Outline and load or create the text to export. 

3 Position the cursor at the beginning of the block of text you want to export. 

4 Choose this function. 
5 Move cursor to end of text you want to export. 

6 Press 4 to signify you have completely marked the block (Esc cancels the com- 
mand), and exporting begins. 

Export Options 
When exporting files, you have to determine how the text is to be exported. You can 
pick a predefined mode containing certain settings or you can manually create your 
own. 

After you choose Export Options at the Advanced Menu, you'll see an option box 
where you choose the export mode. If you pick any mode other than "Manual," the 
rest of the settings in the option box are automatically set when you press F10 to save 
the options. In Manual mode, you have to pick each setting yourself. 
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Once you save your settings with F10, they remain the same until you change them 
again. All exported files will use these same settings. The modes available and their 
default settings are listed below. 

Word Wrap Mode 
Use word wrap mode for programs that support word wrap. Soft carriage returns 
(where word wrap occurred) are typed as a space in order to let the receiving program 
format the word wrap itself. Text is exported as follows: 

H Hard carriage return = hard carriage return 

W Soft carriage return = space 

w Soft space = nothing 

w Leading space = nothing 
Start each line with = nothing 

Line-By-Line Mode 
Use line-by-line mode for programs that require a hard carriage return at the end of 
each line. Text is exported as follows: 

H Hard carriage return = hard carriage return 

w Soft carriage return = hard carriage return 

w Soft space = space 

H Leading space = space 
H Start each line with = nothing 

Spreadsheet Mode 
Use spreadsheet mode for a spreadsheet that requires a 4 at the end of each line. Text 
is exported as follows: 

H Hard carriage return = .1 

W Soft carriage return = 4 

w Soft space = nothing 

w Leading space = nothing 
H Start each line with = apostrophe 
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Manual Mode 
Use manual mode if you want to individually set each of the five settings. Any time 
you change one of the settings, it will automatically switch into manual mode. These 
are the options for each setting: 

,v. Hard carriage return = hard carriage return or .1 

Soft carriage return = hard carriage return, .1, or space (simulate word wrap) 

Soft space (from justification) = nothing or space 

Leading space (from paragraph indents) = nothing or space 

Start each line with = nothing, apostrophe (!), quotation mark ("), caret (^),or plus 
sign (+ )  

Export Speed 
Use this option with any of the four modes described above to set the speed of export- 
ing keystrokes to slow, medium, o~fast. The default i s  medium because some pro- 
grams can't handle very fast typing. Most applications can handle the fast speed, so 
it's probably worth your while to try it. 

Import Block 
Use this function to copy information from another program's screen into PC-Outline. 
This function works only with the memory-resident version of PC-Outline and does 
not work properly with applications running in any graphics modes. 

C A U T I 0 N Make sure you have set the import options correctly before you start 
the importing process. See "Import Options" below for more information. 

Follow these steps to import information from another program: 

1 In your other program, display the information that you want to copy into 
PC-Outline. 

2 Invoke PC-Outline. 

3 Position the cursor in PC-Outline where you want the text to be inserted. 

4 Choose the Import Block function. 

5 You will be shown your previous program's screen. Position the cursor in the upper 
left corner of the text you want to import and press 4. 

6 Position the cursor in the lower right corner of the text you want to import and 
press 4. 
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Import Options 
When importing files, you have to choose whether each line of imported text should 
be ended with a hard carriage return or with word wrap. 

After you choose lmport Options at the Advanced Menu, you'll see an option box 
where you choose the import mode. Once you save your import mode with F10, it 7) 
will remain the same until you change it again. All imported files will use this same 
setting. 

Key Help ( F I )  
This function displays a help screencontaining the function of most of the special keys 
used in PC-Outline. 

Flatten Whole Outline 
Use this function to flatten the entire outline, prttmoting all elements up to the top 
level. 

C A U T I 0 N This function is not reversible and should be used with great caution. 



to Your Needs 
Now that you're familiar with the basics of outlining, it's time to learn some of 
PC-Outline's many features. These features are designed to provide a complete, 
efficient program for you to use to develop your ideas and organize your thoughts. 

This chapter is divided into five applications. Each application demonstrates several of 
PC-Outline's features while introducing a new way of using PC-Outline to accomplish 
your daily tasks. 

Note that each application starts by listing the features introduced in that section. The 
text is designed to allow you to learn the features by reading or by following along in 
PC-Outline. 

The five applications are 

H To-Do Lists How to organize your daily activities. 

Sorted Lists How to use PC-Outline as a simple database to keep track of con- 
tacts, phone numbers, and other information. 

Templates and Macros How to create frequently used pieces of outline structure 
and store them for repeated use. Also shows you how to customize shortcut key- 
strokes. 

Project Management How to use PC-Outline as a simple project manager. 

Using Windows How to use several windows to your advantage in all your other 
applications. 
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Application I : TO-DO Lists 
Features covered in this section include 

Using the Title Toggle function 

Creating outline elements 

Moving outline elements 

Markinglunmarking outline elements 

Moving marked outline elements 

One of the most valuable uses of PC-Outline is management of your daily tasks. By 
taking just a few minutes every morning to add new items to your list and to generate 
a list of today's activities, you can control even the most hectic jobs. Try the following 
method to get your day under control. 

List Making 
On the first level of the outline, keep your list of tasks to do. Whenever you think of a 
new task, just add it using Create New Outline Entry from the Outline Menu (or ̂ N or 

As children of each of these tasks, keep the subtasks or the little tidbits of knowl- 
edge that you'll need to remember. 

If you're using PC-Outline in the memory-resident mode, just press ̂ \ from within your 
other software, and PC-Outline will pop up instantly. In this mode, you'll be able to 
jump in and out of your to-do list whenever a new idea strikes. 

By just jotting down tasks as you think of them, you might end up with a to-do list like 
the one shown below. Try putting together your own to-do list in this format. 

T I  P If you want the title of your list, "MY TO-DO LIST," to be unnumbered, use Title 
Toggle on the Display Menu to turn numbering off for the first element. 

MY TO-DO L I S T  
A .  F i n i s h  t h e  Johnson  Company c o n t r a c t  

1 .  D e l i v e r  t o  p o s t  o f f l c e  b y  5 p.m. ! ! !  
B. T a l k  t o  t h e  b o s s  a b o u t  a  r a l s e  

1 .  How a b o u t  a 1 0 %  I n c r e a s e ?  
2 .  Maybe a  s t o c k  o p t l o n ?  

C. Roses f o r  o u r  anniversary 

I .  DON'T FORGET ! !  2 6  Feb 
2. Get  p e a r l  e a r r i n g s  w rapped  a t  j e w e l e r s  
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Prioritizing Your List 
Now you can prioritize your tasks using Move Outline Entries ("M) from the Outline 
Menu. Don't worry about the subtasks; PC-Outline will automatically move them with 
the task. In fact, to help you move an element quickly around a complicated outline, 
PC-Outline will hide all the text and subtasks while you manipulate the position of the 
main level task. 

Prioritizing could help make your outline more orderly like this: 

MY TO-DO L I S T  C r a n k e d  i n  o r d e r  o f  i m p o r t a n c e )  

A .  R o s e s  f o r  o u r  a n n i v e r s a r y  
1 .  DON'T FORGET ! !  2 6  F e b  
2.  G e t  p e a r l  e a r r i n g s  w r a p p e d  a t  j e w e l e r s  

B. F i n i s h  t h e  J o h n s o n  Company c o n t r a c t  
1 .  D e l i v e r  t o  p o s t  o f f i c e  b y  5 p . m .  ! ! !  

C .  T a l k  t o  t h e  b o s s  a b o u t  a  r a i s e  
1 .  How a b o u t  a  1 0 %  i n c r e a s e ?  
2.  Maybe a  s t o c k  o p t i o n ?  

Remembering Today's Tasks 
If you use a to-do list frequently, you may find that certain items become important 
each day and have to be done that day. Every morning after you enter any new tasks, 
just browse through the outline and use Marldunmark Outline Entry from the Outline 
Menu (or the F2 key) to mark any items that require attention today. PC-Outline uses 
the concept of marks to allow for faster editing of multiple elements. Note that a 
marked element's number wil l  appear in reverse video. 

Then, at the top of the outline, create a new element called "TODAY'S LIST." Remem- 
ber to use Title Toggle to turn off numbering for this line. You can then use Move 
Marks from the Outline Menu to gather all of today's high priority items in one place. 
Notice that these elements are on the same level as the element they were copied to. 
To make them children of "TODAY'S LIST," mark these same two again and choose 
Indent Marks (F8) from the Outline Menu. 
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MY TO-DO L I S T  

A. TODAY'S L I S T  
1 .  Roses f o r  o u r  a n n i v e r s a r y  

a )  DON'T FORGET ! !  2 6  Feb 
b )  Get  p e a r l  e a r r i n g s  w rapped  a t  j e w e l e r s  

2 .  F l n i s h  t h e  Johnson  Company c o n t r a c t  
a )  D e l i v e r  t o  p o s t  o f f l c e  b y  5  p.m. ! ! !  

B. ITEMS FOR LATER CONSIDERfiTION 
1 .  T a l k  t o  t h e  b o s s  a b o u t  a  r a i s e  

a )  How a b o u t  a  10% I n c r e a s e ?  
b )  Maybe a  s t o c k  o p t i o n ?  

Application 2: sorted ~ists 
Features covered in this section include 

Sorting an outline level 

Hiding and showing children and text 

You can use PC-Outline like a simple database to keep track of categories of data. For 
example, the sample file shown below keeps track of prospective customers and some 
pertinent data pertaining to each of them. The colons (:) indicate the start of a new 
field of information. 

PROSPECTIVE CUSTOMERS 

T a l k e d  t o  O r d e r e d  

Name Phone# L a s t  Week L a s t  Mon th  
A. Sue S m l t h  : 555 -9316  :Yes :Yes 
B. J i m  Johnson  : 555 -6133  :Yes :No 
C. Pam M l l l e r  : 555 -0456  :No :No 
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Now, when you get ready to make your weekly sales calls, you can quickly sort 
through all your prospective customers and call those you haven't talked to in the last 
week. Or, using Sort Outline Level from the Outline Menu, you can sort the last field 
to see who hasn't ordered for over a month. This would leave the outline looking like 
this: 

PROSPECTIVE CUSTOMERS ( O r g a n i z e d  b y  i m p o r t a n t  c o n t a c t s  t o  make) 

T a l k e d t o  O r d e r e d  
Name Phone# L a s t  Week L a s t  Mon th  
A .  Pam M i l l e r  : 5 5 5 - 0 4 5 6  :No : No 
B. J i m  Johnson  : 5 5 5 - 6 1 3 3  :Yes :No 
C. Sue S m i t h  : 5 5 5 - 9 3 1 6  :Yes :Yes 

As you get ready to call each person on your list, just use Current Entry's Text from 
the Show Menu to display any information you recorded about this individual. These 
hidden notes could help you be a better salesperson. 

In the expanded form for a specific customer, your outline might look something like 
this: 

PROSPECTIVE CUSTOMERS ( w i t h  some n o t e s  t o  h e l p  y o u  make t h e  
s a l e  t o  Pam M i l l e r )  

T a l k e d  t o  O r d e r e d  
Name Phone# L a s t  Week L a s t  M o n t h  
A .  Pam M i l l e r  : 5 5 5 - 0 4 5 6  :No :No 

D u r i n g  o u r  p r e v i o u s  phone  c a l l ,  Pam p r e f e r r e d  XYZ Company's 
l o w e r  p r i c e s .  Be s u r e  t o  t e l l  h e r  a b o u t  o u r  new q u a n t i t y  
d i s c o u n t s  t h a t  make o u r  p r i c e s  l o w e r  t h a n  XYZ! 

B.  J i m  Johnson  : 5 5 5 - 6 1 3 3  :Yes :No 
C. Sue S m i t h  : 555-931 6 : Y e s  :Yes 

Application 3: Templates and Macros 
Features covered in this section include 

Copy marks 

Writing and reading structured files 

Creating and using redefined keys 
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Some of your uses of PC-Outline may call for a repetitive pattern of keystrokes. These 
patterns usually fall into one of two categories: (1) a form (called a "template") that 
allows you to just fill in the blanks, or (2) a set of keys that either form a series of com- 
mands or a text string (called a "macro"). In this section, you'll learn how to create 
both templates and macros. 

Using Templates Repetitively in an Outline 
Some outlines may call for the repetitive use of certain groups of elements. If so, try 
organizing your outline so that all elements in a series are members of the same fam- 
ily. For a simple project management exercise, you might organize elements like this: 

A. TASK NAME: 
1 .  L e a d e r :  
2.  Team Members: 

a 1 
b) 
c )  

3. D a t e  N e x t  A c t i o n  Due: 
4 .  Description: 

To use this family as a template, choose MarklUnmark (F2 key) from the Outline 
Menu to mark this entire family. Then move up to the title element (since you can't 
copy an element onto itself) and choose Copy Marks (F9 key) from the Outline Menu 
to reproduce this simple template. By repeating this several times, you can generate 
plenty of templates, each ready for you to enter only the pertinent new information 
without having to retype the pattern each time. 

T I P Don't forget to keep an extra blank copy of the template at the bottom of your 
document so you'll still have a blank template left to copy. 

Using Templates to Form an Entire Outline 
If you use a general purpose outline like the weekly form memo shown below, you 
can create an outline template to be used each week. To build the outline template, 
use Set Device for Output from the Print Menu and Input Other File Types from the 
File Menu. 
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To begin typing this memo, choose Title Toggle on the Display Menu. Type the top 
part of the memo, pressing 4 at the end of every line. When you're ready to turn out- 
line numbering back on, press "4, and finish the memo. 

MEMO 

T o  : Distribution 

From: Joe Team Leader 

Date: 

Subject: Weekly Project Meeting Notice 

The next meeting will be held 
in the conference room. 

A. Old Business 
1 .  
2 .  
3 .  

B. New Business 
1 .  

2.  
3 .  

C. Distribution: 

1 .  Manufacturing Manager 

2. Q.A. Manager 
3. Engineering Manager 

After typing the memo, save it to disk by choosing Set Device for Output from the 
Print Menu. Since you want the structure of the outline to be maintained for future 
use, choose the Structured File option from the submenu. When you choose Go Start 
Printing, you'll be prompted for a filename for the outline. 

Now the next time you have another meeting and want to use the template, choose 
Input Other File Types from the File Menu. Choose Structured File again, and when 
you are prompted for a filename, type the name you used to file the outline originally. 

Creating Macros by Redefining Keys 
PC-Outline provides a Key Redefinition function you can use to assign any series of 
keystrokes to a single key. For example, you could create the same outline family that 
is shown in "Using Templates Repetitively in an Outline," and assign it to a single key- 
stroke. 

To redefine a key, choose Key Definition ("K) from the Advanced Menu. Then choose 
a key to define. You can choose any single keystroke to define or any key together 
with Shift, Alt, or Ctrl. For this example, the F3 key will do. 
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Notice that the cursor is now a blinking half cursor. This is to remind you that you 
are in the Key Definition mode and that every key you press is being remembered 
by PC-Outline. 

You can type just about anything into a macro that you could normally type. The only 
restriction is that you can't redefine another key. For this example, create the same 
outline family that is shown in "Using Templates Repetitively in an Outline." 

A. TASK NAME: 

1 .  L e a d e r :  

2. T e a m  Members: 
a 1 
b 1 
c 1 

3. D a t e  Next A c t i o n  Due: 

4. Des c r i p t i o n :  

Note: If you make a mistake, press ̂ Break and start over. 

When youtre*done, press ^Break to tell PC-Outline to stop remembering keys. Press 
Alt-A, 0, and S to save the new key definition permanently. Now whenever you press 
the F3 key, all the keys that you typed will be inserted into PC-Outline. You don't even 
have to keep a copy of the template around. Just press the F3 key and you'll have a 
new copy. 

T I P You may want to reassign the cursor diamond keys-̂ E, Ŝ, ^X, and ̂ D-to 
work as they do in Wordstar. Follow the steps above, pressing the appropriate arrow 
key. Remember, however, that once you've created macros for these keys, you can no 
longer use the original functions for these commands. Disregard the "shortcut" refer- 
ences to these keystrokes on the menus. 

Application 4: Project Management 
Features covered in this section include 

1 Creating outline elements 

1 Moving outline elements 

Sorting outline levels 

Finding strings 

In the early stages of a project, many people find that the most difficult task i s  getting 
the jumble of ideas, tasks, resources, and time durations organized into a legible and 
sensible order. As the project progresses, it becomes necessary to track progress and 
figure out how things are going on a regular basis. You may find that PC-Outline offers 
a very simple and convenient solution to both of these problems. 
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Start your project by letting your ideas flow into PC-Outline. Just create a new element 
for each idea using Create New Outline Entry from the Outline Menu. Once 
you have all or most of your ideas out of your head, you can think about organizing 
them. You can use the straightforward method of moving individual elements around 
with Move Outline Entry (^M) from the Outline Menu, or you can try using a more 
efficient method like sorting. 

Take a look at a couple of methods of organizing a project. Your projects might require 
different formats for organization, but these examples will help you think of just what 
you need to track and how best to track it. 

Tracking Solutions to Problems 
For tracking the solution of several problems, try this format: 

A. PROBLEM: Next Actlon Due: Stage of Completeness . . .  
(Use the text region to fully describe the problem) 
1 .  Symptom 

(Use text to descrlbe fully) 
a) Observer - 
b) Date Found - 

2. Cause 
(Use text to describe fully) 
a) Researcher - 
b) Next Action Due-Date Found - 

3. Solutlon 
(Use text to descrlbe fully) 
a) Solver - 
b) Next Action Due-Date Found - 

Note: Save this file on filename PROJECT. You'll need it to complete the next applica- 
tion. 
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Tracking and Sorting Tasks 
For tracking tasks, try this format: 

A. T A S K  : D a t e  D u e  : P e r s o n  Responsible 
( U s e  t e x t  t o  d e s c r i b e  t a s k  f u l l y )  

1 .  S u b t a s k  A  : D a t e  D u e  : P e r s o n  R e s p o n s l b l e  
( U s e  t e x t  t o  d e s c r i b e  s u b t a s k  f u l l y )  

2. S u b t a s k  B : D a t e  D u e  : P e r s o n  R e s p o n s i b l e  

3. S u b t a s k  C : D a t e  D u e  : P e r s o n  R e s p o n s l b l e  

4. S u b t a s k  D  : D a t e  D u e  : P e r s o n  R e s p o n s l b l e  

As your project list gets longer, you can become more efficient by using the sort func- 
tion. In the above example, you can use Sort Outline Level from the Outline Menu to 
sort by any of the fields preceded by a colon (:). 

To quickly find all the tasks that involve a specific item, use Find String (^F) from the 
Edit Menu to locate the first mention of that item. Just follow the instructions and an- 
swer the questions that appear on your screen, and PC-Outline will start the search 
and find the first occurrence of the string you specify. 

To find the next occurrence, use Find Again (^A) from the Edit Menu. This will repeat 
Find String using the same settings. 

Application 5: Using windows 
Features covered in this section include 

Opening new windows 

Switching between windows 

Using multiple windows 
Transferring text and elements 

Closing windows 

In this application, you'll open two windows containing two different outlines and 
share information between them. This application uses the file you created in Applica- 
tion 4 in addition to the new file you'll create in this application. 
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Opening New Windows 
To get started, load the file PROJECT into PC-Outline. Then choose New Outline New 
Window from the Window Menu. When you're prompted for a filename, type list. 

You'll then see the familiar working screen with the "A." that indicates the start of a 
new outline document. Although it appears that you've just replaced the PROJECT 
outline with a new blank outline, notice the "2" in the upper-right corner of the 
screen. This indicates that you've opened up a second window in PC-Outline. 

Each window contains a separate outline file. By repeating the above process, you can 
load up to nine windows into PC-Outline at one time, provided your computer has 
sufficient memory. Note that by using Load Outline New Window from the Window 
Menu, you could also load an existing file into a new window. 

Switching between Windows 
Multiple windows allow you to switch between outline files and exchange material 
between them. Use Transfer Windows from the Window Menu (or Alt-I) to switch 
back to the first window, where the PROJECT file i s  located. Your screen reverts to the 
outline from the previous application. Use Transfer Windows again (or AH-2) to return 
to the LIST window. 

Listing and Arranging Windows 
Before entering any information into this outline, briefly examine a few of the features 
that will help you use windows efficiently in PC-Outline. 

To see a list of the windows in use, choose List Windows from the Window Menu. 
This list shows all windows and the files they contain, whether any unsaved changes 
have been made to them, and their current file size. The following example shows 
what List Window would show if you had two windows open. 
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To view all currently open windows, choose Arrange Windows from the Window 
Menu. The open windows will be displayed in an orderly fashion as shown below, 
with the window bar of each outline displayed. 

Changing the Size of Windows 
Although a window fills up the entire screen, you can use Size Window from the Win- 
dow Menu to change a window's size. You can change the size of a window from full 
screen all the way down to just a very small rectangle. By using this feature, you can 
see the contents of one or more other windows while working in your current window. 

Once you have a window adjusted to a smaller size, you may want to bring it back to 
full size, work in it, and then reduce it to its original size. To do this, choose Zoom 
Window from the Window Menu. You can also use the gray - (minus) key to toggle 
between the full screen and its reduced size. 

Finally, to make this process of using multiple windows easier, you can move a win- 
dow to any location on the screen as long as the window is always visible and is  not 
full size. Just choose Move Window from the Window Menu, and use the cursor keys 
to move the window. Once you have it where you want it, you can lock it into place 
by pressing 4. 
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Transferring Information between Windows 
Now that you know how to use multiple windows, you can share material between 
them. First, create the following heading in LIST. 

A. T R A C K I N G  P R O J E C T  XYZ 

Now use Transfer Windows to move back to the PROJECT outline. Then copy the en- 
tire PROJECT outline to LIST as a child of this element. To do this, put the cursor on 
the top line and press ̂ Q (Copy Family). Then press Alt-1, position the cursor under 
the heading in LIST, and press 4. The result should look like this: 

A .  T R A C K I N G  P R O J E C T  XYZ 
1 .  PROBLEM: Next A c t i o n  Due: S t a t e  of C o m p l e t e n e s s  . . .  
a) S y m p t o m  

1 )  O b s e r v e r  - 
2) D a t e  F o u n d  - 

b) C a u s e  

1) R e s e a r c h e r  - 
2 )  Next Action D u e / D a t e  F o u n d  - 

C )  S o l u t i o n  

1) S o l v e r  - 
2) Next A c t i o n  Due-Date F o u n d  - 

Closing Windo ws 
In this application, you've learned how to create a window, how to manipulate infor- 
mation within a window, and how to exchange information between windows. There 
is only one other item to learn about windows: how to close them. 

First, save the new outline by choosing Save Current Outline from the File Menu. 
Then choose Close Window from the Window Menu to close the currently active win- 
dow. You cannot close the last open window. But if you want to get rid of an outline in 
the last open window, just use Load Existing Outline or Start New Outline from the 
File Menu to replace the existing outline with the new one. 
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Quick Key 
Reference 

F U N C T I O N  

Block, copy 
Block, delete 
Block, move 
Boldface, begin 
Boldface, end 
Change current driveldirectory 
Children hidelshow toggle 
Clear all marks 
Code display toggle 
Configuration settings 
Copy block 
Copy family 
Copy marks 
Cursor left one word 
Cursor right one word 
Cursor to beginning of line 
Cursor to bottom of screen 
Cursor to end of file 
Cursor to end of line 
Cursor to end of paragraph 
Cursor to next element on same level 
Cursor to parent 
Cursor to previous element on same level 
Cursor to top of file 
Cursor to top of paragraph 
Cursor to top of screen 

K E Y  

Alt-EC or "C 
Alt-ED or ^E 
Alt-EM or ^B 
" F3 
^ F4 
Alt-FC 
Gray + 
Alt-F2 
Alt-F1 
Alt-AC 
Alt-EC or "C 
Alt-WQ or "Q 
Alt-OY or F9 
^+ 

t̂ 

Home 
End End 
^End or Shift-End 
End 
Shift-PgDn 
Shift 4 
"PgUp 
Shift- r 
^Home or Shift-Home 
Shift-PgUp 
Home Home 

(continued) 
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F U N C T I O N  

Date, insert live 
Date, insert static 
Delete block 
Delete line 
Delete outline family 
Delete to end of line 
Delete word left 
Delete word right 
Directoryldrive, change 
Display codes 
Display menus 
Divide outline element 
Double strike, begin 
Double strike, end 
End of file 
Export block 
Export options 
Family move 
File options 
Find and replace 
Find string 
Find string again 
Flatten outline 
Font select 
Format page 
Hanging indent 
Help 
Hide all text entries 
Hide children 
Hide level children 
Hidelshow children toggle 
Hide text toggle 
Hide this text entry 
Hide this text level 
lmport block 
Import options 
lndent and hang 
Indent, clear 
lndent current entry 
lndent marks 
lndent paragraph 
Ins/overwrite toggle 
Insert deleted text 
Insert live date 

K E Y  

Alt-AV or Shift-F2 
Alt-AD or Shift-F1 
Alt-ED or "E 
"Y 
Alt-OD or "D 
Shift-Del 
Shift-- 
Shift- 
Alt-FC 
Alt-PI or Alt-F1 
F10 or Alt-menu letter 
Alt-OU or "U 
Shift-F5 
Shift-F6 
"End or Shift-End 
Alt-AE 
Alt-AP 
Alt-WW or "W 
Alt-FF 
Alt-ER or "R 
Alt-EF or "F 
Alt-EA or "A 
Alt-AF 
Ah-PS 
Alt-PF 
Alt-EH or "0 
Alt-AH or F1 
Alt-HE 
Alt-HA or "H 
Alt-HB or "1 
Gray + 
"PgDn 
Alt-HC 
Alt-HD 
Alt-AI 
Alt-AM 
Alt-EH or "0 
Alt-EX or "X 
F6 
Alt-OI or F8 
Alt-El or "I 
"C or Ins 
Alt-U or Alt-EU 
Alt-AV or Shift-F2 
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F U N C T I O N  K E Y  

lnsert live time 
lnsert non-break space 
lnsert static date 
lnsert static time 
Italics, begin 
Italics, end 
Join outline elements 
Jump to parent 
Key, define 
Key definition options 
Line, delete 
Line feed, printer 
List windows 
Load existing outline 
Load outline new window 
MarkIUnmark 
Marks, clear all 
Marks, copy 
Marks, indent 
Marks, move 
Marks, promote 
Menu display 
Move block 
Move family 
Move marks 
Move outline elements 
Move cursor word left 
Move cursor word right 
New outline elements 
New window new outline 
Numbering, reset 
Numbering, skip 
Numbering, start new 
Page advance, printer 
Page break control 
Paragraph down 
Paragraph indent 
Paragraph style 
Paragraph up 
Place outline entry 
Print 
Print code display 
Print destination 
Print range 

Alt-AX or Shift-F4 
"F10 
Alt-AD or Shift-F1 
Alt-AT or Shift-F3 
" F5 
" F6 
Alt-OJ or "J 
"PgUp 
Alt-AK or "K 
Alt-A0 
"Y 
AIt-PL 
Alt-WI or "Z 
AIt-FL 
AIt-WL 
A l t - 0 0  or F2 
AIt-F2 
Alt-OY or F9 
Alt-Ol or F8 
Alt-OV or Shift-F10 
Alt-OP or F7 
F10 or Alt-menu letter 
Alt-EM or "B 
Alt-WW or "W 
Alt-OV or Shift-F10 
Alt-OM or "M 
"+- 
"-+ 

Alt-OC or ^N 
AIt-WN 
AIt-DU 
AIt-DS 
AIt-DN 
Ah-PP 
AIt-EP 
Shift-PgDn 
Alt-El or "I 
Alt-DC or "T 
Shift-PgUp 
AIt-DP 
Alt-PC or "P 
AIt-PI 
AIt-PD 
AIt-PR 

(continued) 
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F U N C T I O N  K E Y  

Printer formatting 
Promote current entry 
Promote marks 
Quit PC-Outline 
Read other file types 
Rename current outline 
Replace 
Reset outline places 
Right margins, even 
Save outline 
Show all children 
Show all children at level 
Show all family text 
Show all offspring 
Show all text at level 
Show entry's children 
Show text, current entry 
Show text, whole outline 
Show whole outline 
Sort outline entries 
Space, insert non-break 
Start new outline 
Style, default set 
Style, global set 
Style, range set 
Subscript on 
Subscript off 
Superscript on 
Superscript off 
Switch to window number 
Tab set 
Time, insert live 
Time, insert static 
Title, add 
Top of file 
Underline, begin 
Underline, end 
Undelete 
U nindent paragraph 
Up one entry same level 
Window arrange 
Window close 
Window family copy 

AIt-EO 
F5 
Alt-OP or F7 
Alt-FQ 
AIt-FI 
Alt-FR 
Alt-ER or "R 
Alt-DA 
Alt-DE 
Alt-FS or "S 
Alt-SF 
Alt-SB 
AIt-SI 
Alt-SH 
Alt-SD 
Alt-SA 
Alt-SC 
Alt-SE 
Alt-SC 
Alt-OS 
"F10 
Alt-FN 
Alt-DD 
Alt-DG 
Alt-DR 
" F7 
A F8 
Shift-F7 
Shift-F8 
Alt-WT or Alt-1-9 
AIt-ET 
Alt-AX or Shift-F4 
Alt-AT or Shift-F3 
Alt-DT 
"Home or Shift-Home 
" F1 
" F2 
Alt-Eu or Alt-U 
Alt-EX or AX 
Shift- r 
Alt-WA 
Alt-WC 
Alt-WQ or "Q 



Q U I C K  K E Y  R E F E R E N C E  

F U N C T I O N  

Window family move 
Window list 
Window move 
Window number, switch to 
Window size 
Window zoom 
Word left 
Word right 
Zoom/unzoom toggle 
Zoom window 

K E Y  

Alt-WW or ^W 
Alt-WI or ^Z 
AIt-WM 
Alt-WT or Alt-1-9 
AIt-WS 
Alt-WZ 
A- +- 
A m +  

Gray- 
Ah-WZ 




